
CADlink Technology Corporation
© December 2010

Trial Guide



2Table of Contents

Table of Contents
Contact Information.........................................................................................................................................................3
Limited Warranty on CADlink Products ......................................................................................................................4
Copyright Notice...............................................................................................................................................................4

Introduction to SignLab	 5

Installing SignLab	 6
Part 1 - Program Installation...........................................................................................................................................7
Part 2 - Printer Installation..............................................................................................................................................7
Part 3 - Cutter Installation...............................................................................................................................................8
Part 4 - Queue Creation...................................................................................................................................................8
Part 5 - Launching SignLab.............................................................................................................................................9

Sending Jobs from SignLab	 10
Deciding when to Cut, Print, Print&Cut, etc..............................................................................................................11
Choosing Registration Marks and Alignment Systems..............................................................................................12

Sending Jobs to Visual Production Manager (VPM)	 13

Highlights for SignLab	 14
Total Solution Modules...........................................................................................................................................15
SignLab for VersaWorks™ Edition.......................................................................................................................16
SignLab for Mimaki™ Edition..............................................................................................................................16
Streamlined Steps for Print and Cut Jobs.............................................................................................................16
Image and Color Support.......................................................................................................................................17
Transparency (Opacity) Support............................................................................................................................17
Send to SignLab Plug-ins........................................................................................................................................18
Contour Path Plug-in for CorelDraw....................................................................................................................19
Import/Export Files................................................................................................................................................19
Power Tools...............................................................................................................................................................20
General Feature Improvements.............................................................................................................................20

Highlights for Visual Production Manager	 22
Printing.......................................................................................................................................................................22
Print and Cut.............................................................................................................................................................23
Send to VPM Plug-ins.............................................................................................................................................24
Job Management.......................................................................................................................................................26
Layout Controls........................................................................................................................................................27
Media Support...........................................................................................................................................................29



3Contact Information

Contact Information
After using this guide to configure your shop equipment, you should have a good impression of  how the tools can be used 
to improve your shop efficiency. However, if  you have questions about the SignLab Trial, then please contact either your 
assigned dealer, or CADlink directly.

Internet

www.cadlink.com
www.signlab.com

E-mail

sales@cadlink.com

United States

500 Main Street
Clinton, MA 01510
Tel: 1-800-545-9581
Fax: (613) 247-1488

Canada

2150 Thurston Drive
Ottawa, ON K1G 5T9
Tel: (613) 247-0850
Fax: (613) 247-1488

Europe

Intech House, Wilbury Way
Hitchin, Herts, U.K. SG4 0TW
Tel: ++44(0) 1462-420222
Fax: ++44(0) 1462-420111

Germany

Georg Christoph Neller Str. 3
D-54296 Trier
Tel.: +49 (651) 96644840
Fax.: +49 (651) 96644841



4Warranty and Copyright Notice

Limited Warranty on CADlink Products 
CADlink warrants that the disk medium upon which the product is recorded, and any hardware accompanying said 
disk(s), shall be free from defects in materials and workmanship -- under normal use and service for a period of  ninety 
(90) days from the date of  delivery, as evidenced by a copy of  the receipt.
CADlink’s entire liability and exclusive remedy as to the disk(s) or hardware shall be at CADlink’s option -- either (a) 
return of  the purchase price, or (b) replacement of  the disk(s) or hardware that do not meet CADlink’s Limited Warranty. 
These must be returned to CADlink postage pre-paid with a copy of  the receipt.
If  failure of  the disk(s) or hardware has resulted from accident, abuse or misapplication, CADlink shall have no 
responsibility to replace the disk(s) or hardware, the replacement will be warranted for the remainder of  the original 
warranty period or thirty (30) days, whichever is longer. Other then the above limited warranty, CADlink makes no other 
warranties whatsoever, either legal or conventional, express or implied, with respect to the licensed software and hardware. 
You are advised to test the licensed software thoroughly before relying on it. You assume the entire risk of  using the 
licensed software. Because of  the diversity of  conditions and hardware under which the licensed software may be used, 
no warranty of  merchantability or fitness for a particular purpose is given. Some regions do not allow the exclusion of  
implied warranties, so the above exclusion may not apply.

Copyright Notice
PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-
identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone, 
Inc. trademarks are the property of  Pantone, Inc., 2010.
Pantone, Inc. is the copyright owner of  color data and/or software which are licensed to CADlink Technology Corp. to 
distribute for use only in combination with SignLab. PANTONE Color Data and/or Software shall not be copied onto 
another disk or into memory unless as part of  the execution of  SignLab and/or Visual Production Manager.
No part of  this publication may be reproduced mechanically or electronically or in any form without the prior written 
permission of  CADlink. The software described in this manual is furnished under license and may only be used or copied 
in accordance with the terms of  such license. The information in this manual is for informational use only, is subject to 
change without notice and should not be construed as a commitment by CADlink. CADlink assumes no responsibility or 
liability for any errors or inaccuracies that may appear in this document. SignLab®, SignLab Vinyl®, SignLab Print and 
Cut®, SignLab Vinyl Pro®, Visual Production Manager®, Visual Print Manager®, and Digital Factory® are registered 
trademarks of  CADlink Technology Corporation.

Written and designed at CADlink Technology Corporation
2150 Thurston Drive, Ottawa, ON, Canada, K1G 5T9
Phone (613) 247-0850
Fax (613) 247-1488
Manual & Package Design by CADlink Marketing and Customer Support.
Printed in Canada. Product of  Canada.
© December 2010, CADlink Technology Corporation
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Introduction to SignLab
SignLab is Computer Aided Design (CAD) software for signmakers, which provides leading edge technologies as an all-in-
one package for efficient sign shop operation. Development for SignLab is an ongoing process, where new technologies 
and tools are incorporated into SignLab to support modern sign shop needs. Despite the pressure to add new features, 
radical changes to the user interfaces and workflows are avoided, so that signmakers are not inconvenienced when 
upgrading to the latest SignLab.
SignLab tools are simple and versatile for designing with text, line art, and images (i.e., bitmaps). SignLab also provides 
significant support for other design applications, so that unfinished or archived designs can be brought into SignLab for 
pre-production work.

Visual Production Manager
Included with SignLab Print and Cut is the Visual Production Manager (VPM), which is a production management tool 
that serves as a repository for all of  your volume production printing and/or cutting activities. Sorting and accumulating 
jobs is accomplished by creating one-or-more queues for each of  your machines, thereby providing a simple means for 
designers to output their designs.
From a designer perspective, a queue in Visual Production Manager appears as a print destination (i.e., in the application 
Print dialog), and designers are otherwise insulated from the technical aspects of  production. However, for the operator 
that oversees production, they are presented with a clean interface that allows them to preview jobs at a glance, and 
intuitive controls that can be set behind-the-scenes.

Send to VPM Plug-ins
As a means of  avoiding the Print dialog configuration steps within your PhotoShop, Illustrator and/or CorelDraw 
packages, special plug-ins are provided that allow a design to be sent directly to SignLab or VPM. In this manner, you have 
increased freedom to choose the workflow that best suits your production requirements.
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Installing SignLab
Though not required for this Trial, the full SignLab package is provided with an orange USB security dongle to prevent 
unauthorized use or pirating of  the software. This dongle is a flash drive that plugs into a standard USB port of  the 
computer, and it is transparent to other applications. Only SignLab is aware of  the device.

Policy On Lost Or Stolen Dongles
□□ The USB dongle provided with SignLab is your proof  of  purchase. If  the dongle is lost or stolen, then that is 

equivalent to losing the entire software package, and a new package of  SignLab must be purchased.
□□ In the event of  a damaged dongle that must be replaced, there is a nominal fee for EXCHANGING a new dongle for 

the older dongle, where the older dongle must be reclaimed by CADlink.
This fee is waived where product is still under warranty.

□□ Regardless, it is recommended that you ensure that your dongle is covered under your business insurance policy.

Temporary License Files
□□ License files are included with your USB dongle, which are used to confirm the features within your CADlink 

products.
□□ If  a replacement dongle is being shipped to you, then you will typically be issued “temporary” license files that will 

enable you to continue using your CADlink products.
□□ Temporary license files will cease working after a set criteria, though the expectation is that your replacement dongle 

will arrive prior to expiry.
□□ Please note that the replacement dongle will be provided with new “permanent” license files that will replace the 

temporary license files.

Storing Your License Files
□□ In the event of  lost license files, there is a nominal administrative fee for issuing replacement license files.

The fee is waived if the Free Support period is still active. Otherwise, replacement license file issues are treated like Tech Support 
requests.

□□ When CADlink sends you new license files, it is important that you create backups of  the license files, so they can be 
easily located when re-installing your CADlink products on new equipment.

□□ In the case of  the orange USB flash drive dongle, your license files can be stored on the dongle itself. When re-
installing your CADlink products, license files upon the dongle will be automatically used.

For the full SignLab package, 
connect your orange dongle 
BEFORE installing your 
SignLab software!
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Part 1 - Program Installation
The following steps are an overview of  installing the SignLab Trial, and further information is provided within each stage of  the install 
wizard.

1.	 Insert the SignLab Trial CD into your CD-ROM drive. The install wizard should “auto start”.

If  the install wizard fails to auto start, then start the installation process manually:

a)	 From the Start menu, choose Run to open the Run dialog.
b)	 Click Browse and locate the setup.exe file that is on the CD in the CD-ROM drive.

c)	 Click Open to choose the setup.exe file, and click OK to close the Run dialog.

2.	 Proceed with each stage of  the install wizard. Instructions are provided at each stage.

3.	 When the install wizard is complete, proceed to Part 2- Printer Installation.

Part 2 - Printer Installation
Now that SignLab has been installed, you are ready to install the printer support files. However, if  you using this Trial to evaluate either 
SignLab Vinyl or SignLab Vinyl Pro, then you can skip ahead to Part 5 - Launching SignLab.

1.	 Before proceeding, make certain that your Internet connection is active, such that printer support files can be downloaded from 
CADlink.

2.	 From the Windows Start menu, choose All Programs >> SignLab >> Visual Production Manager.
3.	 The First Time Setup dialog will prompt for your default layout settings.
4.	 The Create Queue Wizard will launch (Introduction page), which will be used to install support files for your printer and/or cutter.

At this time, it is recommended that you install the support files for your primary production equipment. Later, it will be possible to 
install support files for additional machines.

5	 From the Introduction page, click Next.
6.	 From the Printer Defaults page (Fig. 1):

a)	 Click the Install Printer button, and follow the steps for choosing the printer model and installing its printer support files.
b)	 Once the support files have been installed, click the Port drop-list and indicate the computer port that the printer is connected to.
c)	 To the right of  the Print Mode drop-list, click the ellipsis button.
d)	 From the Print Mode Selection dialog, use the drop-lists to refine the selection of  print modes (i.e., media profiles), such that you 

can choose the most appropriate print mode for the loaded inks and media.
e)	 From the Printer Defaults page, click Next to proceed.

Fig. 1 - From the Printer Defaults page, install and 
configure your first printer. Later, more printers can be 
installed using Devices menu >> Manage Devices.
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Part 3 - Cutter Installation
1.	 From the Cutter Defaults page (Fig. 2), click the Install Cutter button and follow the steps for choosing the cutter model and installing 

the cutter driver.
For hybrid printers that can perform their own cutting, the printer name will be available as a Cutter drop-list option.

2.	 Once the cutter driver has been installed, click the Port drop-list and indicate the computer port that the cutter is connected to.
3.	 From the Cutter Defaults page, click Next.

Part 4 - Queue Creation
Click Next to proceed through each remaining step of  the wizard.

Note: For CorelDraw, Illustrator and PhotoShop, installation of  the SignLab Garment Decorating Module automatically installs special shortcuts 
that pre-configure your designs for garment printing.

1.	 The Name Your Production Queue page asks you to provide a meaningful name that this queue will be referred to.
□□ For garment printing, set the name as “White T-Shirts”, and later we will create a queue for black shirts.

2.	 The Media Setup page asks you to define the size and margins of  the printer that this queue will be sending jobs to.
□□ For garment printing, you will want to use Fixed Sheet or Templates. If  unsure, then choose  Fixed Sheet and indicate the total 

print area.
□□ Roll is used for roll-feed printers, where you have a continuous roll of  media and want to print continuously. Garment printers are 

not roll-feed machines.
□□ Fixed Sheet is used to select a fixed size that will always be used as the target print area for the production queue. For example, this 

allows for repositioning of  the image to accommodate the desired location on a garment (e.g., position the graphic in the upper-
corner of  the Visual Print Manager for a breast-pocket location, or centered for a chest graphic).

□□ Templates are defined by you to provide specific control over positioning, such as setting custom board sizes and positions for both 
single and multiple jobs.

3.	 The Registration Marks page asks for the alignment system that will be used. Refer to your cutter operation manual for an explanation 
of  the available choices. See also the Choosing Registration Marks and Alignment Systems section, which is within the Sending Jobs from SignLab 
chapter.
If  print&cut jobs will be completed by a hybrid printer that can perform its own cut operations, then the printer will manage its own 
cut alignment. However, if  the cut-portion is to be completed by a stand-alone cutter, then registration marks are printed to provide cut 
alignment.

Fig. 2 - From the Cutter Defaults page, install and 
configure your first cutter. As with printers, more cutters 
can be installed using Devices menu >> Manage Devices.
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4.	 The Layout Mode page asks you to choose how jobs will be nested on the media.
□□ Manual - Add jobs to the Preview Pane without attempting to conserve media.
□□ Auto Nest - Do not use this option for garment printing. This option will reposition newly received jobs to conserve media.
□□ Auto Page - Use this option when garment printing. Append a page break to each job as it is received.

5.	 The Output Options page is used to choose how jobs are held when received by Visual Production Manager.
□□ For garment printing, choose either Hold (i.e., do nothing), or RIP Now, Print later (i.e., spend time creating a spool file, but 

don’t send to the printer yet).

6.	 When ready, click Finish to conclude the wizard, and Visual Production Manager will launch.

Part 5 - Launching SignLab
At this point, you are ready to launch SignLab and output a print and/or cut job. This will confirm that your software and hardware are 
communicating as expected.

1.	 From the Windows Start menu, launch SignLab.
2.	 Since this is a SignLab Trial, a dialog will prompt you to choose the type of  SignLab package that is of  interest (e.g., SignLab Vinyl Pro 

as opposed to SignLab Print and Cut).
3.	 When SignLab is launched, a configuration wizard will automatically open. If  you accidentally close this wizard, then it can be reopened 

from the File menu.
4.	 Proceed with each stage of  the wizard configuration. Once the wizard is complete, the SignLab workspace will be configured for output 

to your printer and/or cutter.

To test that SignLab is communicating correctly with your shop equipment, refer to the Sending Jobs from SignLab section and choose the 
workflow that corresponds to your shop configuration.

Note: For the SignLab Professional Vehicle Graphics Module, please refer to the documentation that is provided within that package.
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Sending Jobs from SignLab
Note: Due to space limitations, the following workflows are provided in the SignLab 9 Setup Guide PDF, which can be 
opened via Start menu >> Programs >> SignLab >> Help Files >> SignLab Setup Procedures.

Once you have completed the SignLab installation, choose from the following workflows to confirm that print and/or 
cut jobs are being received and processed as expected. By completing the workflow that best corresponds to your shop 
configuration, you will develop a greater understand about the SignLab interface.

□□ Deciding when to Cut, Print, Print&Cut, etc. - When in doubt, review these pointers to help you choose the 
workflow that best suits your needs.

□□ Choosing Registration Marks and Alignment Systems - This section provides additional comments about 
aligning cut operations to print jobs.

□□ Print and/or Cut from SignLab - Use this workflow for SignLab Print & Cut packages, where jobs will be processed 
by Visual Production Manager (VPM) and output to a printer and/or cutter.

□□ Contour Cut-only from SignLab - Use this workflow for SignLab Vinyl, Vinyl Pro, and CutPro packages, where jobs 
are output from SignLab to the cutter.

□□ Garment Printing from SignLab - Use this workflow with the Garment Decorating Module to print to both white and 
black garment material. See also the Sending Jobs from PhotoShop/Illustrator/CorelDraw sections.

□□ Cutting Rhinestone Patterns from SignLab - Use this workflow with the Garment Decorating Module to place 
rhinestones and then output the cut pattern to the cutter.

□□ Rotary Engraving from SignLab - Use this workflow with the Engraving Module to configure machine settings within 
SignLab and output a tool path to the engraver.

□□ Laser Engraving from SignLab - Use this workflow to configure SignLab for File menu >> Print output to your 
laser engraver.

□□ Routing from SignLab - Use this workflow with the Sign Routing Module to configure SignLab with material 
definitions, cutting tools, and cut templates for output to a router.

□□ Print and/or Cut to Roland VersaWorks - Use this workflow with the SignLab for VersaWorks™ Edition to configure 
SignLab for sending output to Roland VersaWorks.

□□ Print and/or Cut to Mimaki RasterLink - Use this workflow with the SignLab for Mimaki™ Edition to configure 
SignLab for sending output to Mimaki RasterLink.

For workflows that involve sending jobs from third-party design applications to VPM, see Sending Jobs to Visual 
Production Manager (VPM)
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Deciding when to Cut, Print, Print&Cut, etc.
Due to the variety of  supported workflows in SignLab, the following differences should be noted about how jobs are 
output from SignLab:

Printing versus Print&Cut
□□ Both “print only” and “print and cut” jobs can be processed through the Print and Cut command.
□□ A “print and cut” job is like a regular print job, except that contour cut paths are applied after the print portion of  the 

job. For example, stickers are commonly created through a “print and cut” process.
□□ Though the File menu >> Print command is available in SignLab, it is typically used for printing simple drafts or 

customer proofs to a desktop printer, whereas large format printing should be performed through the Print and Cut 
command.

Contour Cutting versus Print&Cut
□□ When using the Print and Cut command, all workspace shapes are considered to be print-only objects, except 

contour cut paths that represent cut-only objects.
□□ Cut paths are created using the Cut menu tools, such as Contour Cut, Contour Cut On/Off, or Die Cut.
□□ The Print and Cut command is not available with SignLab Vinyl, Vinyl Pro, or CutPro packages. Instead, cut jobs are 

sent via Cut menu >> Plot.
□□ When using Cut menu >> Plot, all workspace shapes are treated as cut-only objects.

Contour Cutting versus Routing or Engraving
□□ For both the SignLab Sign Routing Module, and the SignLab Engraving Module, the Tool Path Tools are first used to 

create tool paths, and then jobs are sent via Cut menu >> Plot.
□□ If  contour cut paths are output to a router or engraver, the cut paths will be of  zero depth (i.e., the cut path will score 

the material).
□□ Since laser engravers use a Windows printer driver, such jobs are sent from SignLab using File menu >> Print.

Visual Production Manager, VersaWorks, and RasterLink
□□ Print and cut jobs sent from SignLab will be received and processed through the Visual Print Manager, unless either 

the SignLab for VersaWorks or SignLab for Mimaki Editions have been purchased.
□□ For the SignLab for VersaWorks Edition, the Print to Roland VersaWorks command will process jobs through your 

VersaWorks RIP software (either queue A or B).
□□ For the SignLab for Mimaki Edition, the Print to RasterLink command will cause jobs to be processed through your 

Rasterlink RIP software.
□□ Regardless of  the choice of  RIP, the software should be launched prior to sending the job from SignLab, rather than 

rely upon Windows to launch the RIP software automatically.
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Choosing Registration Marks and Alignment Systems

SignLab provides support for an extensive variety of  printers and cutters, both in terms of  manufacturers and machine 
models. However, the technology used for printer-cutter alignment varies, such as the following:

□□ Hybrid printers that automatically align cut operations after completing the print job.
□□ Printers that automatically print registration marks that will be used for cut alignment.
□□ For print-laminate-cut jobs, where the printed job will be laminated and loaded back into the hybrid printer for 

cutting, the printer will typically print the registration marks that it needs for cut alignment. 
□□ Cutters that have optical eye systems (i.e., a laser) that can automatically align to specific types of  registration marks.
□□ Cutters that do not have optical eye systems, which require that the operator visually position the cutting tool 

according to the registration marks. In such cases, it is recommended that Three point automatic registration marks 
be created (if  available).

□□ For cut vinyl applications, cutting registration marks that are used to visually align multiple layers of  color vinyl.

When configuring your printer and/or cutter, it is important to consider both the job application, and the choices of  
printer/cutter alignment that are detailed within the Operator Manuals of  the given machines.
Depending upon the type of  work being performed, it may be necessary to manually add registration marks within 
SignLab, or to automatically add registration marks within Visual Production Manager.

Registration Marks in SignLab
□□ In SignLab, choose Shapes Tools >> Registration Mark to manually place individual registration marks.
□□ Likewise, choose Shapes Tools >> Multi-Registration Mark to place sets of  registration marks.
□□ The Multi-Registration Mark tool is also available in Cut Preview mode (i.e., for cut-only jobs).
□□ These tools are typically used for cut vinyl applications, though they can be equally applicable for print&cut 

applications, provided that the marks are placed according to the Operator Manual guidelines.

Registration Marks in Visual Production Manager
□□ Visual Production Manager can automatically add registration marks when jobs are received.
□□ Depending upon how the queue is configured, marks can be added for individual jobs, or for sets of  jobs that have 

been nested upon the media.
□□ Automatic registration marks can be set as follows:

1.	 Choose Queue menu >> Properties.
2.	 Click the Registration Marks tab.
3.	 From the Select registration system drop-list, choose the type of  registration marks (Fig. 3).

Fig. 3 - If the registration system is set as “disabled,” then Visual 
Production Manager will not automatically create registration 
marks.
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Sending Jobs to Visual Production Manager (VPM)
Note: Due to space limitations, the following workflows are provided in the SignLab 9 Setup Guide PDF, which can be 
opened via Start menu >> Programs >> SignLab >> Help Files >> SignLab Setup Procedures.

There are a variety of  means that jobs can be sent directly to Visual Production Manager, as opposed to importing or 
linking the design into SignLab first.

For the PhotoShop, Illustrator and CorelDraw workflows,  a special Send to VPM plug-in that is used instead of  File 
menu >> Print. For garment printing, there is also a Send to VPM with Underbase plug-in that will automatically create 
a white ink underbase for the design.

□□ Sending Jobs from PhotoShop - In PhotoShop, the Send to VPM plug-ins are available through the File menu >> 
Automate flyout.

□□ Sending Jobs from Illustrator - In Illustrator, the Send to VPM plug-ins are available under the File menu. 
□□ Sending Jobs from CorelDraw - In CorelDraw, the Send to VPM plug-ins are available as buttons on the Standard 

toolbar.

□□ Sending Jobs from Other Design Applications - Where the Send to VPM plug-ins are not available, this workflow 
describes how to configure File menu >> Print to send jobs from your third-party graphic design application to 
VPM.

□□ Importing Designs Directly into VPM - If  a saved design file is available, it can be imported directly into VPM.

□□ Sending Jobs Across a Network - This workflow uses Windows remote printer sharing to send jobs from one 
Windows system to another Windows system.

□□ Sending Jobs from Non-Windows Computers - This workflow uses a specially designated Hot Folder for VPM to 
receive jobs from non-Windows systems.

□□ Sending Jobs from Mac OSX to VPM - This workflow uses Windows remote printer sharing in combination with 
Samba (SMB) networking protocol, such that Mac OSX applications can File menu >> Print directly to VPM.

For workflows that involve preparing and sending jobs from within SignLab, see Sending Jobs from SignLab
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Highlights for SignLab
The following sections highlight key features and functionality that have been added as of  SignLab 9:

□□ Total Solution Modules

□□ SignLab for VersaWorks™ Edition

□□ SignLab for Mimaki™ Edition

□□ Streamlined Steps for Print and Cut Jobs

□□ Image and Color Support

□□ Transparency (Opacity) Support

□□ Send to SignLab Plug-ins

□□ Contour Path Plug-in for CorelDraw

□□ Import/Export Files

□□ Power Tools

□□ General Feature Improvements

□□ Highlights for Visual Production Manager
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Total Solution Modules

The following add-on modules (Fig. 4) are now available with SignLab, though it may be necessary to confirm (through 
either CADlink or your dealer) that the chosen module is available for your SignLab package.

□□ SignLab Professional Vehicle Graphics 
Module - This 3-dimensional modeling 
module is used for visually presenting your 
vehicle graphic and wrap designs. Either a 3D 
rendering or short video-clip can be provided 
to the customer in order to help you sell your 
work.
The module package includes documentation 
and tutorials.

□□ SignLab Garment Decorating Module 
- This module contains tools for both direct-
to-garment T-shirt printing, and rhinestone 
garment decoration. For garment printing, 
specialized tools provide an easy means of  
preparing designs for printing on white, black 
or color material. For rhinestone decoration, 
a variety of  techniques are available for 
automatically distributing rhinestones across 
vector and bitmap designs.

□□ SignLab Sign Routing Module - Create 
simulated 3D text and graphics quickly and 
easily using powerful 3D chisel algorithms 
and v-carve technology. A broad variety of  
substrates are supported, and the tool pathing 
algorithms are (as much as) twice the speed of  
competing software.

□□ SignLab Engraving Module - This module 
contains engraver-specific production 
tools, fill routines, and machine support 
that includes both the latest engravers and 
legacy equipment. Produce engraved signage, 
plaques, labels, etc. quickly and easily. Tools 
include optimized sort routines, sorting and 
sequencing of  jobs according to color, and 
instant tool path previewing. 

Fig. 4 - Examples using the Total Solution Modules:

□□ Top-left: A wrap design applied to a 3D 
model.

□□ Top-right: A printed T-shirt with rhinestones, 
and shoes with rhinestones.

□□ Bottom-left: Routed signage and beveled 
lettering.

□□ Bottom-right: Engraved door plates and 
customized iPod.
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SignLab for VersaWorks™ Edition

This is a specially configured version of  SignLab 
that sends designs directly to your VersaWorks™ 
queues and your Roland™ printer. Print quickly 
and easily to either queue ‘A’ or ‘B’ directly from 
SignLab using File menu >> Print to Roland 
VersaWorks. Includes the VersaWorks™ 
color palette for easy color matching with the 
VersaWorks™ swatch.

SignLab for Mimaki™ Edition

This is a specially configured version of  SignLab 
that sends designs directly to your RasterLink™ 
RIP software using an easy File menu >> Print 
to RasterLink workflow, so that you can benefit 
from reduced design and production time using 
tools that are specifically applicable to wide-
format, digitally printed signage.

Streamlined Steps for Print and Cut Jobs

□□ The Print and Cut preview state has been 
removed.

□□ In previous versions of  SignLab, the Print and 
Cut preview state would preview job layout 
upon the media, and then the job could be 
output from SignLab. This preview state is no 
longer used, and instead the job layout can be 
inspected within Visual Production Manager 
(Fig. 5).

□□ Layout activities such as copies, tiling and 
nesting of  jobs upon the media can now be 
performed in Visual Production Manager 
(VPM).

□□ All registration marks and the cutter driver 
are now configured within Visual Production 
Manager, so jobs can be reassigned to 
alternative queues (i.e., cut using a different 
machine).

Fig. 5 - In the revised Print and Cut workflow, 
simply choose the queue within Visual Production 
Manager (VPM) that will receive the job. When 
received, the job layout can be previewed and 
adjusted.
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Image and Color Support

□□ CMYK Color Management - Expanded on-screen 
color management now includes the display of  
imported CMYK images, which avoids the potential 
for color shifts between RGB and CMYK color 
spaces.

□□ CMYK Color Mode - Likewise, images created within 
SignLab can be set as CMYK color mode, which 
expands upon the previous RGB, Grayscale, Indexed 
Color and Monochrome modes.

□□ CMYK Gradient Fills - In addition to previous 
gradient fill tools, new gradient fills have been 
introduced for specific use with CMYK colors.

□□ Optimized Memory Handling - Though not an 
explicit feature, the underlying code within SignLab 
has been significantly optimized with respect to 
previous versions, such that manipulation of  large 
images should be noticeably improved.

□□ Publish PDF with Color Matching - When 
publishing your design as a PDF proof, you can now 
specify whether the PDF is for on-screen display, or 
for a printed proof. This will ensure that the customer 
sees the expected design colors.

Transparency (Opacity) Support

□□ Transparency Support - For imported design files 
that contain an alpha channel (i.e., a transparency 
layer), SignLab can preserve the transparency.

□□ Transparency Gradient Fills - These fills create 
gradient effects that allow the underlying objects to 
“show through” (Fig. 6).

□□ Extended Transparency Tools - These tools are 
provided for easy transparency adjustments, such 
as “make lighter,” “make darker,” or automatically 
knocking out a white background.

□□ Primer and Highlight Conversion - Alternatively, 
if  an imported file contains an alpha channel, then 
SignLab can convert it into primer and highlight 
settings (as used with spot white color printing).

□□ Improved Fluid Mask Support - With the 
introduction of  transparency support in SignLab, this 
enables you to make full use of  the Fluid Mask Blend 
tool when working with difficult foreground subjects, 
like hair. Resulting images can be positioned with new 
backgrounds, and the hair regions will blend naturally 
(Fig. 7).

Fig. 6 - In this transparency example, a black 
rectangle is applied with linear transparency, with 
the handles adjusted to create a dark band at the 
left. When combined with an image, this creates a 
black sidebar where text can remain visible against 
the background.

Fig. 7 - On the right is a stock photo of a 
feather against a black background. On the 
left, FluidMask has knocked out the black 
background, and the resulting image has 
been placed above a yellow oval shape. Notice 
how the Blend tool works in conjunction with 
transparency in SignLab to retain the ruffled 
details of the feather (particularly at the 
bottom left).
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Send to SignLab Plug-in (CorelDraw)
For CorelDraw X3 and later, the Send to 
SignLab button (Fig. 8) provides an easy means 
of  transferring your CorelDraw design to SignLab, 
which can be further modified (e.g., contour cut, 
specialty colors, transparency work, etc.) before 
output for production.
There are three types of  image data that can be 
used when sending a design to SignLab. The 
choice of  image data is situational, per the design 
parameters.

□□ PDF - This is often the best choice for 
maintaining colors as shown in the original 
CorelDraw design.

□□ EPS - This is the best choice for designs that 
contain transparency data, such as shadow 
effects. In SignLab, the EPS Options dialog 
(Fig. 9) will provide further options.

□□ PSD - This option will effectively convert the 
design to bitmap data, which can be a useful 
alternative if  there are issues with using PDF 
or EPS.

Send to SignLab Plug-in (Illustrator)
For Illustrator CS and later, the File menu >> 
Send to SignLab command is available (Fig. 10), 
and a palette can be accessed via Windows menu 
>> Send to SignLab.
There are three types of  image data that can be 
used when sending a design to SignLab. The 
choice of  image data is situational, per the design 
parameters.

□□ PDF - This is often the best choice for 
maintaining colors as shown in the original 
Illustrator design.

□□ EPS - This is the best choice for designs that 
contain transparency data, such as shadow 
effects. In SignLab, the EPS Options dialog 
will provide further options.

□□ PSD - This option will effectively convert the 
design to bitmap data, which can be a useful 
alternative if  there are issues with using PDF 
or EPS.

Fig. 8 - In CorelDraw X3 and later, click the Send to 
SignLab button to send your design as either PSD, 
PDF or EPS data, per your job requirements.

Fig. 9 - When sending EPS data, SignLab will 
provide further options as to how the data 
should be interpreted. For best results, import 
the data as PDF.

Fig. 10 - In Illustrator (version CS and later), either 
use the “Send to” plug-ins that are under the 
File menu, or access palette controls under the 
Windows menu.
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Send to SignLab Plug-in (PhotoShop)
For PhotoShop CS and later, the File menu >> 
Automate >> Send to SignLab command is 
available (Fig. 11). The PhotoShop design will be 
sent to SignLab as bitmap data, which can then be 
further modified (e.g., contour cut) before output 
for production.

Contour Path Plug-in for CorelDraw

The CADlink Contour Path (Fig. 12) button is 
an aid for CorelDraw users that need a convenient 
means of  defining a contour path that encloses 
the given design. When the design is brought into 
either SignLab or VPM, the contour path can 
be converted into a cut path, which will then be 
processed as part of  a print&cut job.
There are two aspects to the Contour Path plug-
in:

□□ Using the Add contour path option, create 
contour paths based upon the current 
selection. Paths can be created for both the 
inner and outer contours of  objects.

□□ After two-or-more contour paths have been 
created, use the Perform basic weld option 
to combine them. Overlapping paths will be 
welded to form contiguous paths.

Import/Export Files

□□ Import and Export Filters - Ongoing 
improvement of  import and export filters 
now includes import of  PhotoShop (PSD) 
files.

□□ Contour Cut Paths in Linked EPS and 
PDF Files - When linking either an EPS or 
PDF file into a SignLab design, CMYK or 
RGB colors can be automatically converted 
into contour cut or halfcut paths.

Fig. 11 - In PhotoShop (version CS and later), use the “Send to” 
plug-ins that are under File menu >> Automate.

Fig. 12 - The CADlink Contour Path plug-in 
provides two functions: 1) create contour paths for 
your design elements, and 2) weld two-or-more 
contour paths into a combined path.
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Power Tools

□□ Easy Menu Board Creation - As part of  
the new Text Compose interface, interactive 
tools have been introduced for constructing 
menu boards, where individual menu sections 
(Fig. 13) can be placed and resized with ease.

□□ Spiral Shape Tool - In addition to the 
existing collection of  basic shape tools, 
spiral shapes can now be created. Like other 
parametric objects, on-screen handles can be 
used to customize the spiral appearance.

□□ Total Area Calculation Tool - For costing 
car wraps, select one-or-more objects that 
represent the physical area that will be 
wrapped (e.g., car doors, hood, etc. from a 
vehicle template), and then perform the area 
calculation.

General Feature Improvements

□□ Text Toolbox in Text Compose - The 
Text Compose interface has been improved 
by grouping features into tabs of  the Text 
Toolbox (Fig. 13).

□□ Character Picker - For unusual characters 
that are difficult to reproduce with a standard 
keyboard arrangement, use the character 
picker in Text Compose mode to display and 
select a desired character.

□□ Custom Sign Blank - As opposed to a 
simple rectangular sign blank, set a custom 
sign blank (Fig. 14) that has unusual shapes or 
contours, such as garments, novelty items, bus 
windows, or non-rectangular can shapes (e.g., 
McDonald’s ‘ M ’ ).

□□ Lasso Select - As opposed to making 
selections with a rectangular selection 
marquee, you can freehand draw an irregular 
region that will select all of  the enclosed 
objects.

□□ Optimized Contour Cut and Vectorization 
- The underlying algorithms for generating 
contour paths and vectorization of  images 
have been optimized, such that previously 
large jobs can now be completed in a fraction 
of  the time.

□□ Job Notes Lookup - A new search feature 
has been introduced for browsing and 
inspecting customer information and job 
history.

Fig. 13 - A menu section with price columns.  Dot leaders 
can be added for readability, and price can be automatically 
aligned to the decimal point.

Fig. 14 - Set a custom sign blank 
shape according to the area and 
shape of the material (in this case a 
T-shirt design).
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□□ New Plug-ins - The collection of  SignLab 
plug-ins have been expanded with more 
CADlink and third-party plug-ins.

□□ Dotted Line for Strokes - Create dashed 
(and dotted) lines that have a specific dash 
length and space between dashes (Fig. 15).

□□ Multiple Stroke Colors - As opposed to 
having a solid stroke color, strokes can be 
composed of  a blend between two distinct 
colors.

Fig. 15 - Both dash and gap length can be quickly applied 
as part of a line style.
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Highlights for Visual Production Manager

The following sections highlight key features that are new in Visual Production Manager as of  the SignLab 9 
release:

□□ Printing
□□ Print and Cut
□□ Send to VPM Plug-ins
□□ Job Management
□□ Layout Controls
□□ Media Support

Printing

□□ RIP Engine – Visual Production Manager is 
a high quality Raster Image Processor (RIP) 
solution that provides PostScript Level 3 
compatible printing for Large Format Printers 
(LFP) and Desktop Printers (DTP).

□□ Direct Printing From Your Design 
Application – Visual Production Manager 
is a seamless interface that can be configured 
to run in the background and serve as a File 
menu >> Print destination for your designers.

□□ Remote Printing Across Networks – For 
designers on a Windows network, or even 
using other operating systems like Mac OSX 
or Linux, extra optional functionality using 
Hot Folders can be used to print despite 
network or hardware limitations (Fig. 16).

Fig. 16 - Design work can be performed using your 
preferred design package with support for Apple 
and Linux-based systems as well. Visual Production 
Manager acts as a print destination and repository 
for print and/or cut jobs.
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Print and Cut

□□ Print and Cut Support – For design applications that support vectors, you can create vectors of  a specific color, 
which can be interpreted as cut paths by Visual Production Manager.

□□ Custom Cut Actions – In addition to cutting vectors of  a specific color, alternative actions and machine settings 
can be set. The machine model determines the available choices, such as: tool velocity, multiple cuts for thick media, 
trailing blade correction, pounce, half  cut, tool number, etc.

□□ Stand-Alone Cutter Support – Queues in Visual Production Manager can be configured to use either a hybrid 
printer that performs its own cut operations, or a printer with stand-alone cutter.

□□ Manual Cutter Calibration – For heavily-used 
cutters that are demonstrating a need for replacement 
parts, Visual Production Manager provides an interim 
software solution (Fig. 17) that compensates for 
gradual shifts in cutter calibration.

□□ Automatic Registration Marks for Cut Alignment 
– If  print&cut jobs will be completed by a hybrid 
printer that can perform its own cut operations, 
then the printer will manage its own cut alignment. 
However, if  the cut-portion is to be completed by 
a stand-alone cutter, then registration marks can be 
automatically printed to provide cut alignment.

□□ Spot White Background for Registration Marks 
– For off-white and clear transparent media, print a 
spot white background for registration marks (Fig. 18), 
thereby enabling cutters with optical eye systems to 
automatically align to the marks. This feature requires 
a printer that is capable of  printing spot white.

□□ Printed Barcodes to Locate Cut Jobs – Visual 
Production Manager supports hybrid printers that can 
read barcodes to locate the cut portion of  print&cut 
jobs. Alternatively, Visual Production Manager 
provides a manual method of  either scanning the 
barcode with a handheld reader, or typing the printed 
identification number.

□□ Sort Cut Jobs – Reduce cutting time by specifying 
the most efficient order in which cut paths should be 
performed.

□□ Weed Borders – A weed border is an additional 
rectangular cut around the primary shape (i.e., small 
script lettering), which is used to avoid stretched media 
when separating shapes from their adhesive backing.

□□ Cut from End of  Roll – For print&cut jobs that use 
a stand-alone cutter, designate that the entire roll will 
be printed, and that the printed roll will then be fed 
into the cutter without rewinding the roll (Fig. 19). 
Visual Production Manager will process the cut jobs in 
reverse order, thereby avoiding the need to rewind the 
roll.

Fig. 17 - Compensate for gradual 
shifts in cutter resolution.

Fig. 18 - Print spot white to 
aid optical alignment systems.

Fig. 19 - Load printed rolls into the cutter without 
needing to rewind the media.
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Send to VPM Plug-in (CorelDraw)
For CorelDraw X3 and later, there are two “Send 
to VPM” buttons (Fig. 20) that provide an easy 
means to transfer your CorelDraw design to 
Visual Production Manager.

□□ Send to Visual Production Manager - This 
plug-in uses PDF data, and it is used to send 
both image and vector data. As such, this 
plug-in should be used to send jobs that are 
ready for printing and cutting.

□□ Send to Visual Production Manager with 
Underbase - This plug-in uses PSD data, and 
it is only used with printers that support white 
ink printing. When the design is sent, a white 
underbase layer is automatically generated that 
will be appropriate for printing on a black or 
color substrate.

Send to VPM Plug-in (Illustrator)
For Illustrator CS and later, there are two File 
menu “Send to VPM” commands (Fig. 21) that 
are used to transfer your Illustrator design to 
Visual Production Manager.

□□ Send to Visual Production Manager - This 
plug-in uses PDF data, and it is used to send 
both image and vector data. As such, this 
plug-in should be used to send jobs that are 
ready for printing and cutting.

□□ Send to Visual Production Manager with 
Underbase - This plug-in uses PSD data, and 
it is only used with printers that support white 
ink printing. When the design is sent, a white 
underbase layer is automatically generated that 
will be appropriate for printing on a black or 
color substrate.

Fig. 20 - For CorelDraw X3 and later, there are two 
“Send to VPM” plug-ins that are used to process jobs 
directly out of CorelDraw. This eliminates the need 
for using File menu >> Print, and instead you merely 
choose the queue that should receive the job in Visual 
Production Manager.

Fig. 21 - In Illustrator (version CS and later), either 
use the “Send to” plug-ins that are under the 
File menu, or access palette controls under the 
Windows menu.
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Send to VPM Plug-in (PhotoShop)
For PhotoShop CS and later, the File menu >> 
Automate >> Send to VPM command (Fig. 22) 
will transfer your PhotoShop design to Visual 
Production Manager.

□□ This plug-in always uses PSD data, and it can 
be used for both print-only, and print&cut 
jobs.

□□ For print&cut jobs, you need to create a path 
in the PhotoShop design that will represent 
the cut line.

□□ For printers that support white printing, 
it is necessary to first delete the default 
“Background” layer, and then create a layer 
with transparency info. The transparency  will 
represent the white underbase that allows the 
design to blend seamlessly into the printed 
substrate.

□□ There are three additional plug-ins (Fig. 23) to 
help you prepare images for printing to black 
or color garment material. They are accessed 
through the Filter menu >> CADlink flyout, 
and are used as follows:
A)	 KnockMeBlackOut - For printing on 

black garment material, reduce the amount 
of  black ink that is required. In effect, 
black is removed from the image, with the 
expectation that the black garment will 
suffice instead of  ink.

B)	 KnockMeColorOut - For printing on 
color garment material, reduce the amount 
of  color ink that matches the garment 
color, with the expectation that the 
garment color will suffice instead of  ink.

C)	 Transparency Opacity - Adjust the 
relative strength of  the transparency layer, 
thereby adjusting the amount of  white 
underbase that will be printed.

Fig. 22 - In PhotoShop (version CS and later), use 
the “Send to” plug-ins that are under File menu >> 
Automate.

Fig. 23 - To help prepare an underbase 
white layer in PhotoShop, use the Filter 
menu >> CADlink plug-ins.
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Job Management

□□ Queue Organization – One-or-more queues 
can organize your jobs for each machine and 
for different types of  media (Fig. 24). By 
accumulating jobs in each queue, they can 
be held until the required media and inks are 
loaded into the machine.

□□ At-a-Glance Queue Switching – Each 
queue is organized as a tab for convenient 
switching (Fig. 25). Merely click to see the jobs 
that have been accumulated, or double-click 
to check the properties of  the given queue.

□□ File Import – Design files can be imported 
directly into Visual Production Manager, 
where they will become a job in the currently 
active queue. Importing a previously 
completed design file avoids the need to pre-
load the file in the original design application.

□□ Inherited Queue Properties – When jobs 
are received in a given queue, they inherit the 
properties of  that queue, thereby removing 
concern from the designer about what settings 
need to be used for the given media and inks.

□□ Job Scheduling – Choose how jobs should 
proceed based upon the type of  job. For 
example, if  print jobs are being held, then 
rasterize the job while waiting. Or for print-
laminate-cut jobs, hold the cut portion until 
after the printed media has been laminated.

□□ Job Archiving – After a job has been 
completed, the job file can be saved for 
sending the job additional times without 
needing to re-send the file from the design 
application. Likewise, if  the spool file has 
been archived, then the job can be resent 
without spending time rasterizing the job.

□□ Job Costing – Ink usage data can be collected 
to predict the production costs associated 
with the completing similar print runs. As 
more data is collected, an average trend in ink 
usage should be apparent, thereby providing 
greater ability to predict anticipated material 
needs for upcoming jobs.

□□ Crop Mark Annotations – In addition to 
marking the bounds of  the print job, crop 
marks can now include job details, such as job 
name, cutter name, job size, etc.

Fig. 24 - Accumulate jobs until the appropriate 
media and inks are loaded.

Fig. 25 - Click a tab to access its queue, or double-
click for queue properties.
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Layout Controls

□□ Visual Print Manager – The Visual Print 
Manager (Fig. 26) previews jobs as they will 
appear on the media. Use this functionality to 
confirm spacing between jobs, positioning of  
jobs, usage of  media, etc., with easy scrolling 
and zooming to inspect the media.

□□ Tiling and Cropping – Visually divide 
(Fig. 27) a large job into tiles by either 
specifying tile dimensions or dragging tile 
lines for careful positioning. Overlap and 
margin amounts are automatically taken into 
account.

□□ Template Media Layouts – Create custom 
page layouts that will automatically place jobs 
at specific positions upon the media (Fig. 28). 
Templates can automatically scale, rotate, 
and create copies. Copies can be scaled and 
rotated on an individual copy basis.

Fig. 26 - The Visual Print Manager 
previews jobs as they appear on 
the media.

Fig. 27 - Tile a job when it 
exceeds the media bounds, or 
crop the design.

Fig. 28 - Template layouts will 
automatically create and position 
copies, including any scaling or 
rotating.
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□□ Automatic Nesting – Collect and reposition 
jobs to conserve media (Fig. 29), and then 
begin printing when there are enough jobs to 
fill an entire sheet or roll. Alternatively, specify 
that printing should begin when a certain 
proportion of  the media can be filled.

□□ Copies – When copies are created within 
Visual Production Manager, only the original 
design will be rasterized, and the job copies 
will reuse the rasterization data (Fig. 30). In 
comparison, if  multiple copies of  a job are 
sent from the design application, then all such 
copies will be rasterized individually (i.e., more 
processing time would be required). Fig. 29 - Automatic nesting will 

collect and reposition jobs to 
conserve media.

Fig. 30 - When making copies, print data will be calculated only 
for the original, rather than process the same data repeatedly.
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Media Support

□□ Online Printer Support File Updates – 
Visual Production Manager already comes 
equipped with a broad selection of  media 
profiles, which are organized according to 
printer model, media, inks, print speed, and 
print quality. The latest support files can 
be quickly obtained through your Internet 
connection (Fig. 31).

□□ Color and Image Adjustments – These 
adjustments to the color and image settings 
can compensate for non-standard media and 
inks (Fig. 32), where the cost of  producing a 
new media profile is otherwise prohibitive.

□□ Ink Volume Control – To improve the 
color saturation of  your prints, use Max Ink 
adjustments (Fig. 33) to increase the volume 
of  ink that is absorbed by the media. Like 
the color and image adjustments, the max ink 
settings can be used to compensate for slightly 
different absorbency of  a substitute media.

□□ Separation Curves – For printers that 
combine inks to obtain a wider range of  hues 
(e.g., cyan in combination with light cyan), the 
separation curves can be adjusted to maximize 
the possible range of  hues.

□□ Custom Halftone Settings – Override 
the halftone settings to obtain the optimum 
frequency, angle and dot shape for high 
quality jobs.

□□ Preview Raw Print Data – Inspect print data 
on-screen prior to printing (Fig. 34), so that 
print data can be confirmed on a per color 
channel basis.

Fig. 31 - Use the Internet to 
automatically download the latest 
printer support files.

Fig. 32 - Color adjustments 
compensate for substituted 
media and inks.

Fig. 33 - Adjust ink 
volume to improve 
color saturation in 
prints.

Fig. 34 - Inspect raw print data before committing to print.


